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Tape recording sparks autrage
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When the publisher of the
McCurtain County Gazette left
his tape recorder running after
the March 6 county commis-
sioner meeting, he thought he
might catch commissioners
discussing county business
with people or topics not on
the agenda after the meeting
adjourned. That would be a
violation of the state’s Open
Meeting Act.

Not only did he record a
discussion of county business,
but the conversation he al-
legedly caught on the tape was
much worse.

When Publisher Bruce
Willingham listened to the
tape, he heard sheriff’s officers
and commissioners discussing
Iynching Black people, killing
Willingham and his son, Chris-

topher, a Gazette reporter, and
mocking a recent fire victim.

Attending the March 6
meeting were Sheriff Kevin
Clardy, jail administrator Larry
Hendrix, Captain Alicia Man-
ning, and commissioners Mark
Jennings and Robert Beck.

The McCurtain County
Gazette broke the story in its
April 16 edition, which includ-
ed a QR code linking to clips
of the audio.

The story went viral, spark-
ing statewide and national out-
rage from citizens, journalists
and public officials. Governor
Kevin Stitt, Congressman Josh
Brecheen and Idabel Mayor
Craig Young called for the res-
ignation of the four McCurtain
County officials.

The McCurtain County
Sheriff’s Office issued a state-

sssssssss

To read all McCurtain County Gazette articles regarding the tape recording, go to

mccurtaingazettenews.com.

ment on Facebook on April
18 claiming the recording was
made illegally and had been
altered.

Willingham refutes the sher-
iff’s claim, having received
legal advice in the five weeks
from the time of the recording
and its release. OPA Executive
Vice President Mark Thomas
said, “These public officials,
including two of three county
commissioners, were meeting
in a public space. There is no
expectation of privacy in a
public space. That’s why peo-

ple are allowed to have video
doorbells that show activity on
a street, or dash cams in their
car, or even pull out a camera
and record things they see on
the street.”

Willingham has been
publisher of the McCurtain
Gazette since 1988, but began
reporting on courthouse cases
in 1980. His son, Chris, has
been a police beat reporter at
the Gazette for 18 years.

Willingham shared some
background of the problems
between the McCurtain

Continued on Page 3

You might need an alibi if
you’re not at the OPA Annual
Convention at the Grand Casi-
no Hotel & Resort in Shawnee
on June 9-10.

With the theme “Journal-
ists: Democracy’s Detectives,”
events this year include a
murder mystery where you’ll
test your sleuthing skills when
you examine the evidence to
find a killer.

Don’t Miss Qut:

Register for OPA Annual Convention by May 19

Register to attend by May
19 so you don’t miss out on
the “early bird” registration
rate. Hotel rooms are available
at the Grand Casino Hotel
& Resort for $99 per night.
For more information and to
register, visit okpress.com/
convention.

The convention begins
at 3:30 p.m. June 9 with the
annual business meeting and

election of 2023-2024 OPA
Officers and Directors.

The general session, “Eye
on the Future: Securing Alter-
native Revenue,” will explore
different revenue streams
to increase visibility and
reduce business risks. Several
state publishers and revenue
managers will discuss their al-
ternative revenue methods and

opportunities they’re utilizing
in their individual markets.

Friday concludes with
a reception and the murder
mystery event.

Saturday morning Craig
Garnett, publisher of the Uval-
de Leader-News, will present
“Covering Tragedy: One Year
Later.” Garnett, who grew up
in Altus, Okla., will discuss

Continued on Page 4
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From the President

By Zonelle Rainbolt

Executive Editor, Wesner Publications  OPA President 2022-2023

Busy doesn’t begin to describe the pace of life for news people as we
enter this portion of the year! Spring sports, end-of-school activities, high
school and college graduations, hail and tornadoes, weddings, the end
of Oklahoma’s legislative session — the list of events that need us to hit
the ground running and then write clear, accurate articles, as well as publish perfect photos, seems
endless. Then throw in a few instances of crime, a special event or two, and it could be easy to feel
overwhelmed.

But, for some reason, instead of being overwhelmed by having multiple events to cover, news
people are energized. We see possibilities and are willing to investigate alternate ways to get the
most news to the most people. We don’t balk at occasionally spending the extra time to attend one
more meeting or traveling to report on a final softball tournament.

What does give us pause, however, is when hardworking people in our industry are maligned,
and even threatened, for doing their job. That job often includes pointing out when people in po-
sitions of authority are not complying with the law. Sometimes our job requires us to make others
uncomfortable or to acknowledge they have made a mistake. It isn’t easy to report on unpleasant,
or even terrifying events, especially for those of us who live in small communities where we will,
at some point, meet the very people about whom we are writing in the green bean aisle of the local
grocery store. What is vital, however, is that we report the truth to the very best of our ability, even
when we know it will cause others to react negatively. We don’t report any news from a place of
malice, but rather an honest attempt to provide our readers with accurate news and to make the
places where we live safer and better.

Our founding fathers recognized the importance of a free press and enshrined the specific right of
freedom of the press in the first of the Bill of Rights. As with all rights, freedom of the press comes
with responsibilities and our Oklahoma journalists are among the best in the world at responsible
reporting. We are also among the absolute best at providing support to our fellow journalists — from
those putting out a school paper twice a year to the individuals who are putting out multiple section
papers every day. We know how important our job is and are willing to make the sacrifices neces-
sary to make sure it is done correctly. What we do, and how we do it, are vital pieces of what keeps
our country strong, and we will never fail to support our fellow journalists as they make the truth
public.

I wish I could visit with every one of you individually to tell you how very much I respect the
dedication you have to our industry. Some of you I know personally and some only by reputation
or through the articles you have written. What I do know, however, even if we haven’t spoken in
person, is that you are hard-working, articulate, and dedicated to outstanding journalism. And what
I hope you know is that I, both personally and as a member of OPA, support the work you do to
report the news. Together, we are unstoppable!
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OPA CALENDAR
OF EVENTS

For more information
on upcoming events, visit

okpress.com/events

Thur., May 25, 2023

OMC WEBINAR:

COVERING OPIOID

LAWSUIT SETTLEMENTS
In this training, journalists will be
provided with a brief history of
the lawsuits and the subsequent
settlements from which this
money is being distributed.

Fri. & Sat., June 9-10, 2023
OPA ANNUAL
CONVENTION
Mark your calendar to attend the
2023 Convention at the Grand
Casino Hotel & Resort in Shaw-
nee. Register online at Okpress.
com/convention

Thur., February 8, 2024

LEGISLATIVE SUMMIT

AT STATE CAPITOL
Publishers and editors are
encouraged to join us at the
State Capitol on February 8 for
the annual Legislative Summit.

ORDER YOUR
2023 PHOTO ID
PRESS CARD

Make
sure you
add a
photo
ID press
card

to your
toolkit.

These
press
cards
are perfect for reporters,

photographers and other staff
members at your newspaper.

Only $7 each!

ORDER ONLINE AT
okpress.com/press-cards

(OKLAHOMA PRESS ASSOCIATION
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YOUR NAME
Publication
555-555-5555




The OPA Board of
Directors will consider one
application for OPA member-
ship during its next meeting
on June 9.

Feed the Children, a
non-profit organization based
in Oklahoma City, has applied
for Strategic Partner member-
ship.

OPA receives membership application

Written protests to the
application must be received
at OPA by Wednesday, June
7,2023. Protests may be
sent to the attention of OPA
Executive Vice President
Mark Thomas at mthomas@
okpress.com or faxed to (405)
499-0048 or mailed to Mark
Thomas, Oklahoma Press

Association, 3601 N. Lincoln
Blvd., Oklahoma City, OK
73105.

Information and applica-
tion forms for OPA’s mem-
bership classifications may
be found at okpress.com/
join. Lists of current members
may be found at okpress.com/
members.

Tape Recording

Continued from Page 1

County Sheriff’s Office and
the newspaper in a letter to
Oklahoma Attorney Gener-

al Gentner Drummond. The
entire letter is available to
view on the Gazette’s website
at meccurtaingazettenews.com/
letter-03-2023.

“The McCurtain Gazette
has conducted a years-long
investigation into corruption,
violence and illegal actions
at the McCurtain County
Sheriff’s Office,” Willingham’s
letter stated.

Since 2021, the McCurtain
Gazette has written 34 arti-
cles about the sheriff’s office.
Willingham’s letter says that
in retaliation for the investiga-
tion, the sheriff’s department
began refusing to release open
record reports of their cases.

In March 2023, the newspa-
per filed a legal action against
the sheriff’s office for viola-
tions of the Open Records Act.

“The Gazette is being

represented pro bono by the
Reporters Committee for
Freedom of the Press regarding
the withholding of reports and
body cams of the tasering and
subsequent death of a hog-tied
man, Bobby Dale Barrick,”
Willingham’s letter reads.

As a result of the filing,
the sheriff’s office released
records, logs and body cam
footage requested by the
Gazette nearly a year ago, the
newspaper reported in an April
20 article. According to the
governor’s office.

District 2 Commissioner
Mark Jennings submitted his
resignation with a handwritten
note.

The Oklahoma State Bureau
of Investigation has opened an
investigation into the situation
in McCurtain County follow-
ing a request from Stitt. Stitt
is also examining all “legal
avenues” to remove Sheriff
Clardy from his office.

On May 5, Drummond in-

formed Stitt that he has asked
OSBI to expand that inves-
tigation “to include wrong-
doing that could trigger the
application of 22 O.S. § 1181,
which sets forth eight potential
grounds for removal.”

Threats made to the McCur-
tain County Sheriff’s Office
prompted the McCurtain Ga-
zette to release the following
Statement:

“The McCurtain Gazette
does not condone any threats
or acts of violence, including
against any elected officials or
law enforcement. We under-
stand and empathize with the
frustration that has come from
Sheriff Kevin Clardy, sherift’s
department Captain Alicia
Manning and Jail Administra-
tor Larry Hendrix’s refusal to
resign despite demand from the
community and the Governor.
However, we also value the
lives of all community mem-
bers and encourage everyone
to remain peaceful.”

You’ve Got Questlons'

e Can | photograph minors without consent?

¢ Can police deny access to records by issuing a press release?
 Should | alter my archives when a person demands it?

* (Can | report inaccurate testimony given in open court?

* What are the laws about liquor advertising?

These are questions answered by the attorneys for the
OPA Legal Services Plan members in recent months. OPA members
always need timely legal advice on issues related to publishing.

You should join OPA’s LEGAL SERVIGES PLAN'

See www.0kPress.com/LSP or contact Mark Thomas N
at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today! A |
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Register for OPA Annual Convention

Continued from Page 1

the decisions he and the staff
made May 24,2022, when 19
children and two adults were
killed at a local elementary
school.

Oklahoma Attorney General
Gentner Drummond will also
speak Saturday morning.
During Drummond’s first
few months in office, he has
shown a renewed focus on
government transparency and
accountability.

Drummond will be fol-
lowed by Oklahoma’s con-
gressional delegation, who has
been invited to discuss import-
ant issues affecting Oklahoma
and local communities.

The Awards Luncheon
features presentations of the
ONF Beachy Musselman
Award, OPA Half and Quar-
ter Century inductions, ONG
Column and Editorial Sweep-
stakes Awards, OGE Photo of
the Year Awards, Magazine
Contest Awards, ONF Joseph
F. Edwards Outdoor Writer of
the Year Award and ONF Ray
Lokey Memorial Award for
Excellence in Reporting.

Speed Topics kicks off the
afternoon sessions. In this fast-
paced session, you’ll choose
which table and topic you want
to join, then change tables ev-
ery 20 minutes. Topics will in-
clude advertising, circulation,
editorial and social media.

The event no one wants to
miss is the Ice Cream Social
and Blooper Show. Get ready
for some laughs as OPA Ex-
ecutive Vice President Mark
Thomas presents this year’s
gaffes.

Concurrent sessions feature
two editorial tracks: Holly
Easttom, a professor at Okla-
homa Baptist University, will
discuss “How to find new story
ideas and write compelling
features” and Richard Barron,
chief photographer at The
Ada News, will present “Tell

powerful stories through your
photos” for the editorial track.

The two revenue tracks
feature Mike Crandall, owner
of Sandler Custom Growth
Solutions in Oklahoma City,
presenting “How to sell to the
modern buyer,” and Cindy
Allen and Leslie Magalios
from the Enid News & Eagle
presenting “Could Al revolu-
tionize sales and marketing?”.

If you need a professional
portrait, there will be an onsite
studio available for two hours
Saturday evening. While
you’re dressed up for the
banquet, stop by and have your
picture taken.

Then it’s time to recognize
the exceptional work you
produced this year. Enjoy a
complimentary drink at the
reception before heading into
the Awards Banquet for the
presentation of the OPA Milt
Phillips Award and Better
Newspaper Contest Awards.

We also want to take this
opportunity to thank the spon-
sors of this year’s convention;
(See list at right.)

OPA again offers a T-shirt
designed to display your pride
in local news publications.
The front of this year’s shirt
features “Local News uncov-
ers the facts.” T-shirts can be
ordered when you register for
the convention or purchased
separately. They can be picked
up at the convention.

Additionally, there will be
a silent auction to raise funds
in support of the Oklahoma
Newspaper Foundation’s paid
internship program. Items will
be on display throughout the
convention with final bids due
before 7 p.m. June 11. If you
have an item to donate, email
details including its value, a
description and minimum bid
to amartin@okpress.com by
June 3.

Register today at okpress.
com/convention and we’ll see
you in Shawnee on June 9-10!

2023 Gonvention Sponsors
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2023 Gonvention Speakers

Craig Garnett Mike Crandall

Richard Barron

Cindy Allen

Leslie Magalios



OPA Nominating Committee recommends
slate of officers & directors for 2023-2024

The OPA Nominating Com-
mittee met at the OPA Building
on March 16 to discuss the
slate of officers and directors
for 2023-2024.

The seven-member commit-
tee is composed of the six most
recent OPA past presidents
who are still active as newspa-
per executives and the current
OPA president.

Committee members in
attendance were Chairman
John Denny Montgomery,

The Purcell Register; Rod
Serfoss, Clinton Daily News;
Jeff Mayo, Sequoyah County
Times; Brian Blansett, Lincoln

County News; Ted Streuli,
Oklahoma Watch; and current
OPA President Zonelle Rain-
bolt, Wesner Publications.

Rusty Ferguson of The
Cleveland American and Ray
Dyer, El Reno Tribune, were
unable to attend.

After reviewing the OPA
By-Laws and discussing possi-
ble candidates, the committee
recommended the following
slate of officers and directors
for the year beginning July 1,
2023.

Sheila Gay, publisher of
Woodward News, was rec-
ommended to serve as presi-

dent. Shauna Belyeu, general
manager of The Eufaula Indian
Journal, was recommended to
serve as vice president. David
Stringer, publisher of The
Lawton Constitution, was rec-
ommended to serve as treasur-
er. Zonelle Rainbolt, executive
editor of Wesner Publications,
was recommended to serve as
past president.

The committee also recom-
mended that current Director
Suzie Campbell, publisher of
the Countywide & Sun, be
re-appointed to fulfill the final
year of Belyeu’s vacated three-
year term, and that Ed Choate,

publisher of the Muskogee
Phoenix, be appointed to fulfill
the second and third year of
the three-year term vacated by
Gay.

Recommended as new
directors to each serve a three-
year term were Mike Sherman,
executive editor of Oklahoma
Watch, and Brett Wesner, own-
er of Wesner Publications.

A general election for new
officers and directors will be
held at the annual convention
during the business meeting
on Friday, June 9 at 3:30 p.m.
at the Grand Casino Hotel &
Resort in Shawnee, Okla.

Uncover the facts in Style!

Showcase the
importance of
your local news
source with an
OPA T-shirt.
The FRONT of
the black shirt
features "Local
News Uncovers
the Facts." The
bottom right
corner features
the OPA Logo.

o

Uncovers the Facts

orLaxow

PRESS

Order your shirt when you register for the
convention or buy it now! Shirts can be picked
up when you arrive at the convention. They will
not be mailed. Order online at.
okpress.com/convention#Tshirts

Order deadline:
May 19
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Carl Albert senior Alex Sutterfield celebrates after winning
the 215-pound state title at the Class 5A wrestling state
championships.

Photo by JEFF HARRISON, Midwest City Beacon, March 1, 2023

At OG&E, we do more than

! : ,
(HER €nergize a power grid.

communitic

MARCH 2023
DAILY, SEMI- AND
TRI-WEEKLY WINNER:

DERRICK JAMES

McAlester News-Capital

MARCH 2023
WEEKLY WINNER:

JEFF HARRISON

Midwest City Beacon

The OGE Photo Contest was judged
by a member of the
Oklahoma Journalism Hall of Fame.

View all winning photos and contest rules at
OkPress.com/OGE-Photo-Contest

Enter and Win a $100 Check from
OGE ENERGY CORP.

For more
information
about the
photo contest,
visit
okpress.com/
oge-photo-
contest

Members of the Tulsa

perform a three-

volley salute during the
funeral service of fallen
McAlester Police Capt.
Richard Parker.

Photo by DERRICK JAMES,
McAlester News-Capital,
March 23, 2023

OGE

We Energize Life

We honor our commitment to strengthen our communities.

©2021 OGE Energy Corp.
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Allie Prater, group editor for Cimarron Valley Communications

Allie Prater, group editor
for Cimarron Valley Communi-
cations, has been named Editor
Extraordinaire, 2023, by Editor
and Publisher Magazine. This

is an honor bestowed on just
12 individuals in the newspa-
per industry across the country
each year.

“It is a huge honor and we

are full of pride for Allie,” said
Cimarron Valley Communi-
cations’ owner and publisher
J.D. Meisner. “There is no
question that Allie is deserving
of this recognition. She has
shown us time and time again
that tenacity, innovation and
hard work pays dividends.”

Cimarron Valley Communi-
cations publishes the Cushing
Citizen, the Yale News and the
Keystone Gusher (formerly the
Drumright Gusher). Accord-
ing to Meisner, Allie manages
the news output of all three
publications, writes a column,
handles most photography and
covers at least one sports event
a week.

“Aside from her nuts and
bolts editorial duties, Allie is
our best ambassador,” said
Meisner. “She started up a
reader advisory board at each
of the group’s papers to collect
input and suggestions from

readers on what they want their
local paper to look like. She
also initiated a student reporter
program and has high school
students stringing for the

paper at sporting and academic
events.

“She meticulously coaches
these kids and guides them in
writing, reporting and photog-
raphy,” said Meisner. “Strictly
by Allie’s suggestions, we
have expanded our coverage
from five communities and five
schools to 18 communities and
14 school districts. This has
not only provided much need-
ed news coverage to areas long
neglected by local news, but it
has expanded the company’s
revenue opportunities.”

This is not Prater’s first time
to be nationally recognized. In
2021, she was chosen as one of
Editor and Publisher’s top 25
editors under 35.

Local editor receives national recognition

Updates from the United States Postal Service

FINAL END DATE FOR
HARD-COPY ADDRESS

NOTICES
The last day for Full Service

and Seamless Acceptance
Periodicals mailers to receive
address changes in hard copy
is July 9, 2023.

USPS had earlier indicated
it would end the printed notice
for all mailers, the National
Newspaper Association
reported. In its final rule, USPS
announced that for Periodicals
not using Full-Service
Intelligent Mail or Seamless
Acceptance, the hard copy
notices will continue to be
available. It also will keep the
“Return Service Requested”
as an ancillary endorsement in
labels.

NNA raised numerous
questions about the proposed
change. The Postal Service

addressed those issues in its
final rule.

Among its responses is an
answer to publishers con-
cerned about automatic address
change downloads corrupting
existing files. It states that
automatic downloads are not
required and that publishers
will be able to print out hard
copy address change reports to
use in their updates, if desired.

It says the change is neces-
sary to save costs. The USPS
analysis suggests that 60% of
the hard copy notices were
produced for mailers already
on automated programs like
Seamless Acceptance, where
electronic notices have been
encouraged for several years.

For Periodicals on Full-Ser-
vice, the use of the electronic
Address Change Service is
free. For mailers having diffi-
culty with enrollment, USPS

invites queries to its helpline at
1-877-672-0007 or by email
MSSC@usps.gov.

RATE INCREASE

July 9 is also when postage
rates for Periodicals will in-
crease. As reported last month
in The Publisher, the increase
will be 8.8% for Within Coun-
ty newspapers and 8.1% for
Outside County newspapers.

The new rates also include a
three-cent increase in the price
of a First-Class Mail Forever
stamp from 63 cents to 66
cents.

The U.S. Postal Service
said the price adjustments are
needed to achieve the financial
stability sought by its Deliver-
ing for America 10-year plan.

HARD COPY POSTAGE
STATEMENTS TO END
The U.S. Postal Service

will require electronic entry
of postage statements after Jan-
uary 28,2024.

Prior to that date, local
Business Mail Entry Units and
postmasters will meet with
mailers currently filing postage
statements to make sure they
understand how to use free
USPS online tools or explore
third-party software vendors’
offerings.

After the deadline, mailers
will be required to enter essen-
tial mailing data directly into
USPS electronic files.

In the past, some mail-
ers have brought their paper
statements or emailed copies
of the statement to the BMEU
for postal clerks to enter data.
After the end date, postal
personnel will no longer have
access to mailers’ records to
provide that entry, according to
USPS.
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Sean Stephens becomes Clinton Daily News publisher

Sean Stephens with his family: Emily, Christy, Natalie and Sean. Photo Courtesy
of the Clinton Daily News.

Sean Stephens has been
named the new publisher of the
Clinton Daily News.

He will only be the CDN’s
third publisher in the past 83
years.

“Sean has been preparing
for this opportunity since
he joined the Daily News
in 1999,” said current CDN
Publisher Rod Serfoss. “I can’t
think of anyone better to be in
charge of this newspaper than
him.”

In his more than 23 years at
the Daily News, Stephens has
worked his way up the chain of
command.

In 2011, in addition to his
duties as sports editor, he
became the Assistant to the
Publisher in order to begin
learning the management side
of the newspaper.

“As he continued to grow
in that role, he was later put
in charge of sales and mar-
keting for the newspaper,”
said Serfoss. “Sean has done
everything I asked of him, and
I am excited to name him as
my successor.”

Stephens joined the CDN as
sports editor after earning his
journalism degree from Cam-
eron University in 1999.

A graduate of Duncan High
School, Stephens is a sec-
ond-generation journalist, as
his mother was once employed
by The Lawton Constitution
and his father was once a free-
lance photographer.

In 2001, he married a Clin-
ton girl, Christy Johnson. They
have two daughters, Emily and
Natalie.

Emily, 18, is currently a

reporter for the Clinton Daily
News. She plans to major in
journalism this fall at the Uni-
versity of Oklahoma. Natalie,
8, is a second grader.

“Clinton is home — I’ve
never wanted to go anywhere
else,” Stephens said. “I wasn’t
born or raised here, but after
living here now almost half my
life, I am more than proud to
call Clinton my home.

“In this new capacity it
will be a privilege to serve the
people of Clinton by endeav-
oring to help direct one of the
best staffs ever to continue to
put out a great newspaper for a
great community.

“It’s a staggering responsi-
bility to become just the third
Clinton Daily News publisher
since 1940. The fortunate thing
is that I had the opportunity
of working for the two men
before me and I am thankful
for all the lessons learned.”

Serfoss has been in the
newspaper business for nearly
58 years, with all but three
of those years at the Clinton
Daily News.

He began delivering news-
papers here in 1965 and went
on to work in and manage
every department at the news-
paper.

In 1988 he became the
general manager of the Sand
Springs Leader. He returned to
Clinton in 1991 to became part
owner of the Daily News.

In 2003 he succeeded

Charles Engleman as publisher
of the Clinton Daily News.

Both were elected president
of the Oklahoma Press Associ-
ation — Engleman in 1957 and
Serfoss in 2010.

They each received the
newspaper association’s high-
est honor — the H. Milt Phillips
Award. The honor went to
Engleman in 1982 and Serfoss
in 2019.

“I believe Sean is more than
capable to continue the Clinton
Daily News legacy started
by Engleman in 1940,” said
Serfoss.

While Serfoss will con-
tinue in an advisory capacity
to the CDN, he has also been
employed by the Oklahoma
Press Association as a business
consultant to its 163 member
publications

“I look forward to working
with newspapers across Okla-
homa in my new role at the
Oklahoma Press Association,”
said Serfoss.

“Being publisher of the
Clinton Daily News for the
past 20 years has been a dream
come true! Now it is time to
pass the torch to Sean and I
look forward to watching him
succeed.

“I am also excited about
my new role with the OPA that
allows me to be able to give
back by helping others in the
newspaper industry so they
can also see their dreams come
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Great content keeps readers engaged

Looking

Them Over
by Rod Serfoss
rserfoss @ okpress.com

The feature story package
titled “Secret Ingredient is in
the Pan,” on the front page of
The Marlow Review gets an
A+!

The headline, photographs,
story and even the jump
line lured readers into this
delightful story.

The story detailed the life
of Carlann Miller’s lifetime
of baking and cooking.
According to the story, when
Miller was seven-years-old,
her father had a stroke and
being a little girl, she wanted
to bake and cook. “My mother
said if you can read it, you can
cook it,” said Miller who has
taught school for 52 years.

The well composed picture
of an elderly lady preparing a
deep-dish peach cobbler with
a determined look on her face
to make it perfect, red long-
handle underwear hanging
behind her on the clothesline
and an open chuck wagon to
the side brought the picture to
life.

The jump line — See “Secret
Ingredient” on page 2 — has
the reader quickly turning
the page to continue reading
the story. That secret wasn’t
revealed until the last words of
the story — “It’s in the pan.”

Two thumbs up to the
staff of the McIntosh County
Democrat for publishing a
high-quality newspaper from
the front to back.

Six page one stories along
with six pieces of art are
accented by high quality press
work.

Eight pages filled with
news and photographs two
opinion pages and four
pages of sports that included
11 stories and 16 pictures

“STHE JOURNAEZ

Fatal heroin overdose victim hated being addicted

4458 monh sspupaetaldon

A New Era in Sapulpa:
The Tee Pee Drive-In Reopens

Front pages featured this month are The Perkins Journal, Sapulpa Herald, and The Marlow Review.

combine to make this a great
NEWSpaper!

The Sapulpa Herald did
a superb job covering the
reopening of Tee Pee Drive-
In on historic Route 66 in
Sapulpa, after it had been
closed for nearly 25 years.

Its grand-reopening pictures
—including a drone photo of
cars packed in the drive-in, the
lit-up iconic sign of the grand-
reopening, people enjoying
the event and even a surprise
engagement proposal — made
readers feel like they were at
the event.

It takes both circulation and
advertising revenue to be able
to publish a good newspaper.
The Perkins Journal has a
good combination of both. It
is good to see advertisements
for a wide range of businesses
throughout the paper. The
newspaper also has a lot of
local news plus great sports
coverage to boost circulation
revenue, and more than 50
ads from area businesses that
ring the cash register on the
advertising side.

The lead story in a recent
edition of The Herald-
Democrat in beaver was about

the top students at Turpin
High School — a community of
around 300 people located 25
miles away.

When looking at papers
like it and The Boise City
News I am reminded that how
close your neighbor is has
a lot to do with where you
live — and in the Oklahoma
Panhandle, 25 miles is like
being next door.

Both are the only legal
newspapers in the county they
serve — The Herald-Democrat
in Beaver County and The
Boise City News in Cimarron
County.

The Boise City News’s
closest neighboring Oklahoma
newspaper is the Guymon
Daily Herald 58 miles to the
east in Texas County. And
for a bit of trivia, Cimarron
County has the distinction of
being the only county in the
United States that touches five
states — Kansas, Colorado,
New Mexico, Texas and its
own Oklahoma.

The next closest Oklahoma
newspapers to The Herald-
Democrat are The Hooker

Advance, 42 miles to the
west, or The Harper County
Leader, 47 miles to the east in
Laverne.

In all, there are only four
newspapers serving the nearly
5,700 square miles that make
up the three counties in the
Oklahoma Panhandle.

It is good to see these four
newspapers doing their part
to make sure people living in
the wide-open spaces of the
Panhandle have a newspaper
they can rely on to keep them
informed.

TOP 5 GREATIVE
HEADLINES

5. “Egg-citing event” —
The Westville Reporter

4. “Frack Monster’ said
to be a noisy neighbor” —
Newcastle Pacer

3. “Victim filmed woman
as she attacked him with a
garden hoe” — Broken Bow
News

2. “She tried to kill me” —
Atoka County Times

1. “Buttocks-biting
brother behind bars” —
McCurtain Gazette

Rod Serfoss, OPA Business Consultant, looks over OPA member publications
for a monthly column, “Looking Them Over.” To contact Serfoss, email rserfoss @

okpress.com.
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Acrobat still best, although there are alternatives

h Computer Notes
=S from the road
oA

Fab

by Wilma Newby
wnewby @ okpress.com

With an annual price of
$239.88 for Adobe Acrobat,
I’m often asked if there are
alternatives to consider.

Alternatives still need to
offer nearly everything Acro-
bat does such as OCR, making
forms and signing PDFs.

Based on that criteria I
went looking. What I found
were attempts to copy the best
program out there.

Nitro PDF has been around
for a while and is being used
at some newspaper offices.

At a cost of $179.99 per year,
Nitro can OCR text and its
PDF combining pages feature
works well. It also allows you
to add a signature field to a
PDF.

The downfall is that it’s
only supported on newer Mac
operating systems. This is the
case with most of these alter-
native programs. Nitro seems
to do it all for a lower cost
than Acrobat and the interface
is simple.

Then there’s Foxit PDF
Editor, a capable program with
all the same features.

Its $149 per year plan
includes digital signing. There
is a separate program for just
signing PDFs but it doesn’t
include all the other features
the Editor version offers. It’s
a simple program with lots of
buttons instead of menus but it

seems to do all that we would
ask of it.

Don’t get the cheaper $99
per month Foxit version if you
need to have signed PDFs. It
requires you to purchase an
extra subscription to Foxit
eSign.

Soda PDF is another PDF
editor that works on Mac and
PC with all the things you
might want. For $155.88 per
year it’s worth the time to look
it over.

There is a free PDF editor
but it is an online based app
that works through a web
browser. It can be found at
https://online.sodapdf.com/

There’s also PDFExpert
that is Apple computer based.
It costs $79.99 annually or
$139 for a lifetime license.
That’s a great deal if you’re
using an Apple computer. It
can be downloaded from the
app store and has built-in
signatures for PDFs.

You might be able to do
some things with programs
already on your work com-
puter. Libra Office Draw will
open PDFs and let you edit
them. Google Docs will open
and OCR PDFs if you have a
Google account set up on the
computer. Google also makes
an extension for web brows-
ers called PDF to OCR that
works if a PDF needs editing.
It converts the PDF to a plain
text file.

ONLINE ONLY PROGRAMS
A very good description of

why big software companies
are trying to take all their pro-
grams online was given to me
last month. I thought I would
share. One of the main reasons
they’re going to online-only
is so they don’t have to pay
someone to update each ver-
sion of the program for all the
different platforms available
today.

That means the compa-
ny doesn’t have to put out
a different version for three
Windows versions and more
than four Apple versions. It
costs money to hire people to
do all that programming. If it’s
an online-only application it
only has to be updated to the
latest web browser.

The problem I see is that
these companies have worked
years to make great applica-
tions for computers — in some
cases 30-plus years.

But it’s like starting over
for them with web versions.
These versions have less
features. It will take years for
them to catch up, if they ever
do. There are many features
that just aren’t on the web
version but end users are being
driven to use these lesser
programs.

It’s extremely hard to use
web-based programs with-
out fast internet. And if the
internet is down, no work can
be done.

I had been wondering why
manufactures keep putting
smaller drives in computers.
It’s because room for pro-

> LEGAL ADVICE

STs.

is just one of the benefits of being a member of the Oklahoma Press
Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION'S
LEGAL SERVICES PLAN

1-888-815-2672 or 405-499-0020

grams will no longer be need-
ed and all files are expected to
be in the cloud. Soon yearly
subscriptions will be need-

ed for all software or we’ll

be pressured into using web
browser programs.

GIMP TUTORIAL

A photo correction program
used by many newspapers
is Gimp. It’s free for Mac or
Windows.

I’m often asked for some
simple instructions for correct-
ing a photo for web press with
Gimp.

If you’re missing tools,
look under the Tools menu.
The Control/Option key is
used with Clone Stamp Tool
and to select an area to be
cloned.

1. The Crop tool works by
selecting the area to be
cropped then double clicking
within that area.

2. Image > Scale Image... To
resize the photo note the drop-
down button next to “px” that
allows viewing in inches.

3. Levels and Curves are under
the Colors menu. Used for
lightening the photo.

4. Filters > Enhance > Sharpen
Unsharp mask. Change the
Amount slider until the photo
looks good. Leave Radius
around 1px. The Threshold
settings should be low, 0-1px.

5. Image > Mode to change
photo to Black/White. There is
no CMYK in this program so
leave as RGB for color photos.
Another prog ram will have to
convert them to CMYK or the
PDF export can make them
CMYK when InDesign makes
the final PDF.

6. File > Export As to save the
file with a name. Note the
Select File Type button at the
bottom to change to the file
format for the photo.

OPA Computer Consultant Wilma Newby’s
column is brought to you by the Oklahoma
Advertising Network (OAN). For more
information on the OAN program, contact
Oklahoma Press Service at (405) 499-
0020.



Transparency is key principle of communication

By John Foust
Greensboro, NC

Joanne is an ad manager
with a common-sense approach
to managing her team and their
goals. She believes in commu-
nication — not micro-manage-
ment — but real communication
on how things are going.

“For years,” she told me, “I
often found out at the eleventh
hour that something wasn’t go-
ing as planned. A crucial email
wasn’t sent in time, a propos-
al was held up by research
delays, or an ad deadline
wasn’t met. Now, those things
can happen to even the best
members of an ad team at the
best of publications. But it puts
everyone in an awkward posi-
tion and threatens to damage
our credibility.

“So, I started relying on a
little saying that I heard a long
time ago: ‘Say what you’re
going to do. Then do it, or
renegotiate.” It has become

a catchphrase around the
office. Start out with a realistic
commitment, by saying what
you’re going to do, whether it’s
to email certain information

to an advertiser by the end of
the week, submit a proposal
by next Tuesday, or have an ad
ready to run by this afternoon.
Then do what you commit-
ted to do — on time. It sounds
simple, but some salespeople
get so excited about a sale
that they have a tendency to
overpromise. That’s where
they can get into trouble by
thinking they can double their
effort and get things done on
schedule. The result is often

a missed deadline or sloppy
proofreading.

“That’s why renegotiating
is so important,” Joanne said.
“As soon as they know things
aren’t going as promised, it’s
best to go back to the other
person and say something
like, ‘I’m sorry the proposal I

promised by next Tuesday has
been delayed. I wanted to tell
you as soon as I found out, be-
cause you have a right to know
exactly what’s going on. Let’s
talk about some alternatives.
Could later next week possibly
work for you? That will allow
us to gather more complete
demographic information and
give you a better view of your
target audience.’Notice how
the statement ends with a bene-
fit to the other person.

“As a manager,” Joanne
explained, “this approach helps
me stay up to speed with what
is happening with our advertis-
ing department. Plus, it shows
the team that this kind of

situation does not mean failure.

It’s just a speedbump along the
way. This is much better than
waiting until the last minute to
tell me, their advertiser or their
coworkers.”

There’s a big lesson in
Joanne’s philosophy. Trans-

parency is a key principle of
business communication. The
word itself indicates “seeing
through,” such as a window
allows us to see what’s on the
other side.

When we are transparent
with other people, we elim-
inate the window shades of
pride and embarrassment
which tempt us to wait “one
more day” before sharing what
we fear could be interpreted as
bad news.

While bad news is not
happy news, this technique can
help keep the lines of com-
munication — and customer
relations — open.

©Copyright 2023 by John Foust. Al rights
reserved. John Foust has conducted
training programs for thousands of news-
paper advertising professionals. Many ad
departments are using his training videos
to save time and get quick results from
in-house training. Email for information:
john@johnfoust.com
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o OKLAHOMA NATURAL GAS CONTEST WINNERS

CONGRATULATIONS TO THE MARCH WINNERS
Column: JEFF MULLIN, Enid News & Eagle
Editorial: JOHNNY McMAHAN, Woodward News

|
MARCH EDITORIAL WINNER (Read editorial online at okpress.com/ong-contest)

JOHNNY McMAHAN, Woodward News
Event Center a venue to celebrate

The Conference Center welcomes everything from
weddings to conventions. Crystal Beach Stadium is as
good a rodeo arena as one will find in Oklahoma. Fuller
Park is a top level baseball facility that can host pretty
much any level of the sport. Boomer Fieldhouse annually
hosts several basketball tournaments.

Then, there is the Woodward County Event Center.

We continue to be amazed at the versatility of this venue.

It hosts numerous stock shows and other events through
the year like major trade shows, but let’s just highlight the
last couple of weeks.

From Feb. 17 through Feb. 28, the event center was the site
of quite possibly the largest spring stock show in Oklahoma
outside of the Oklahoma Youth Expo in Oklahoma City.
Over all the 11 days, some 1,000 exhibitors worked 1,600
animals through the show ring.

That ended with the premium auction on Feb. 28.

After one day off, the event center then hosted back-
to-back regional powerlifting meets for junior high and

high school athletes across Northwest Oklahoma, the
Panhandle and parts of the OKC metro.

Those are two incredibly different events and the turn-
around time isn’t much, but it works — thanks to a lot of
work from a lot of people.

Not every community has a venue to do these different
types of events, nor the people to pull it off in such a rapid
fashion.

Both events bring folks to Woodward which is always a goal
and having a large venue capable of holding just about
anything is a key.

We want to thank everyone who had a hand in making both
events possible and successful.

MARCH COLUMN WINNER (Excerpts from column. Read entire column at okpress.com/ong-contest)

JEFF MULLIN, Enid News & Eagle

Women have gotten short shrift for too long

If you have ever used a circular saw, thank a woman.

Next time you load your dishwasher rather than washing
plates and glasses by hand, thank a woman.

When it rains and you flick on your vehicle’s windshield
wipers to clear your view, thank a woman.

Getting a shot isn’t any fun, but it is necessary to make

or keep you well. Next time you face the needle, thank a
woman.

Enjoy homemade ice cream? Thank a woman.

Do you savor the warm air generated by your car’s heater
on a frigid winter day? Yep, you can thank a woman for
that, too.

All of the above were invented by women. And that’s not
all. Women also invented the Kevlar used in bulletproof
vests, caller ID and call waiting, disposable diapers, laser
cataract surgery, WiFi, GPS, Bluetooth and coffee filters, all
were conceived of and designed by women.

So thank women for all these things. Oh, and if you are
alive and breathing, thank a woman for that, too. There are
plenty of ways to leave this old world but only one way in,
and women play the major role in that process.

March is Women’s History Month and Wednesday is
International Women’s Day. And lest you ask why there is
no International Man’s Day, consider this. Globally, women
earn 77 cents for every dollar earned by a man, according
to the United Nations. Every day, it seems, is man’s day,
and therein lies the problem.

As of last September, according to career website

zippia.com, women made up 58.4% of the U.S. workforce
but held only 35% of senior leadership positions. Of the
CEOs of Fortune 500 firms, only 8.8% are women.

And it's not like women are not highly qualified. In 2020,
41% of U.S. college graduates were women, while females
earned 60% of all U.S. graduate degrees. In 2020, 53% of
all doctorates went to women. But women with doctorates
earned an average of $113,858 compared to the $155,485
earned by men. In fact men with masters’ degrees earned,
on average, 3% more than women with doctorates.

As far as government is concerned, there are presently

15 countries led by women. In America, which has never
elected a woman president, there are a record number of
women serving in the 118th Congress, but that total is only
28% of the members of both houses.

And it’s not like women are a minority in this nation, men
are. Females make up 51% of the U.S. population.
Perhaps it isn't women'’s history we should be concerned
about this month and every month, but the challenges
faced by women today and going forward.

Right here in the Sooner State, women aren’t faring well
atall. In fact personal finance website WalletHub says
Oklahoma is the worst state in the nation for women.
Oklahoma ranks 47th in terms of women’s preventative
health care, 45th in women'’s life expectancy at birth, 43rd
in the number of women living in poverty, 38th in the high
school graduation rate for women and 40th in the number
of unemployed women.

Oklahoma
Natural Gas.

A Division of ONE Gas
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Enter and Win a
$100 Check
from Oklahoma
Natural Gas!

The March
Oklahoma Natural Gas
Column and Editorial Contest
was judged by a member of the
Oklahoma Journalism
Hall of Fame.

1. Each month, submit your entry
online at okpress.com/ong-
contest. Attachments should
be in PDF format.

2. Entries may also be emailed
(full-page tearsheet) to
amartin @okpress.com. Include
the author's name, name of
publication, date of publication
and category entered (column
or editorial).

3. All entries for the previous
month must be at the OPA
office by the 15th of the
current month.

4. Only ONE editorial and/or
ONE column per writer per
month will be accepted.

5. Winners will receive a
Certificate of Achievement, a
$100 check and the column
or editorial may be published
in The Oklahoma Publisher.
Annual Sweepstakes winners
will receive a plaque, a $200
check and may have the
column or editorial published
in The Publisher.

Contest open to staff at OPA
Legal Newspaper and General
News Media members, as well as
OPA Individual members.

The views expressed in winning
columns and editorials are those
of the writers and don’t necessarily
reflect Oklahoma Natural Gas
Company’s opinions.



